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摘要 

    以巰基苯甲酸異構物（對巰基苯甲酸、鄰巰基苯甲酸）與硝酸銅為反應物，巰基苯甲酸

做為配位基與還原劑，採一鍋到底的方式，反應在 70℃下 30 分鐘，可分別合成出粒徑大、分

散性差黃色沉澱並有橘紅色螢光的銅奈米團簇與粒徑小、黑褐色澄清液體具有藍色螢光的銅

奈米團簇。接著以自行設計的簡易螢光光譜儀分析，橘紅色螢光的最大放射波長為 620 奈米，

在丙酮溶劑中，螢光增強，對 pH 值有依賴，並在鹽類、鹼性溶液中，非常不穩定，銅奈米團

簇會分解，黃色沉澱與螢光消失；藍色螢光的最大放射波長為 420 奈米，在丙酮、酒精中，

螢光增加，另外控制溶液的 pH 值 4〜8 與特定鹽類時，可使螢光強度增加，並且穩定性佳，

未來具有做為金屬奈米螢光材料的潛能。 

壹、研究動機 

    二年級自然與生活科技的單元「物質的基本結構」，介紹物質是由原子所組成。當原子規

則、緊密堆積成數千億兆個時成塊材，是巨觀的視野，就如圖一中的銅片，具有紅色的金屬

光澤。銅是自然界中，重要的金屬元素之一，因為其導電性佳，價格便宜，多用於導線，也

可與其他的金屬，製成青銅、黃銅等合金，用途廣泛［1］。近年來，最為關注的議題，就是奈

米科技，當物質的粒子，所組成的原子數十個，其粒徑在 1-100 奈米時，表現在物理與化學 

  

圖一  銅片與銅奈米團簇（在日光下） 圖二  銅片與銅奈米團簇（在暗處） 

性質，是截然不同於巨觀的情形，如圖一中，是由數十個銅原子聚集在一起，表層有巰基配

位錯合物所組成的銅物質，以膠體的方式懸浮於溶劑中，呈黑褐色，不再如銅片一樣，具有

金屬光澤。在暗處，照射紫外燈，可發出藍色的螢光，如圖二，類似分子的特性，這樣銅的

組成，稱為「螢光銅奈米團簇」
［2,3］

。文獻報導指出，「螢光銅奈米團簇」是銜接單一銅原子與

塊材（銅片）間的性質，有良好的化學穩定性，毒性低，其表層亦含有官能基，可增加奈米

團簇對於分析物的選擇性或生物辨識性，於化學、生物檢測、材料及催化方面具有潛力。因

此，對於平日所見的銅，尺寸落在奈米等級時，竟然可以有螢光，呼應老師在介紹奈米知識

時，物質在巨觀與微觀的視野，性質迥然不同，我們覺得十分的有趣，想一探「螢光銅奈米

團簇」其中的奧妙之處。 
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貳、研究目的 

    由於銅奈米團簇擁有極小且均一的尺寸，優異的光穩定性，故本實驗的研究目的有: 

一、合成螢光銅奈米團簇物質 

二、以自製的螢光光譜儀分析研究螢光銅奈米團簇物質的螢光性質 

參、研究設備及器材 

一、研究設備 

1. 電子天平 1 台；2. 刮勺 2 支；3. 稱量紙 50 張；4. 水銀溫度計 1 支；5. 加熱攪拌器 1 台；

6. 鐵鍋 1 個；7. 大型紙箱 2 個 ；8. 黑色壁報紙 2 張；9. 樣本瓶 5mL10 個、10mL5 個、20mL5

個；10. 微量吸管（micropipette）1mL1 支、200μL1 支 11. 微量吸管吸頭 1mL10 個、200μL20

個；12. 滴管 10 支；13. 燒杯 50mL 10 個、100mL 10 個；14. 方形玻璃試管 2 個；15. 攪拌子

1 個；16. 黑色膠帶 1 捆；17. 剪刀 1 把；18. 自製分光器 1 個；19. 數位照相機 1 台；20. 照

相機腳架 1 台；21. 雷射筆 1 支；22. 紫外燈（波長 250nm、365nm ）1 台；23. 影像分析軟

體 Image J；24. 數據分析軟體 Microsoft Office Excel 2007；25. 省電燈泡；26. 檯燈燈座 

二、研究藥品 

1. 硝酸銅 Cu(NO3)2∙6H2O 500g 1 瓶；2. 硝酸 HNO3 500mL 1 瓶；3. 四氫呋喃 （THF）500mL 1

瓶；4. 二甲基甲醯胺（DMF）500mL 1 瓶：5. 對巰基苯甲酸（4-MBA）5g 1 瓶；6. 鄰巰基苯

甲酸（TA）5g 1 瓶；7. 藥用酒精 500mL1 瓶；8. 丙酮 500mL1 瓶；9. 鹽酸 HCl500mL1 瓶；10. 

硝酸鉀 KNO3 500g 1 瓶；11. 氯化鈣 CaCl2∙2H2O 500g 1 瓶；12. 六水合硫酸銨亞鐵

Fe(NH4)2(SO4)2∙6H2O 500g 1 瓶；13. 硫酸 CuSO4∙5H2O 500g 1 瓶；14. 硫酸銨(NH4)2SO4 500g 1 瓶；

15. 氯化亞鈷 CoCl∙6H2O 500g 1 瓶；16. 硝酸鉛 Pb(NO3)2 500g 1 瓶；17. 硫酸鋅 ZnSO4 500g 1 瓶；

18. 碳酸鈉Na2CO3 500g 1瓶；19. 磷酸氫鈉Na2HPO4 ∙12H2O 500g 1瓶；20. 氫氧化鈉NaOH 500g；

21. R.O 逆滲透水；22. 廣用試紙 1 盒 

肆、研究過程或方法 

    我們研究過程分成兩部分，一是合成螢光銅奈米團簇物質，二是探討螢光銅奈米團簇物

質的螢光性質： 

一、合成螢光銅奈米團簇物質：螢光銅奈米團簇的製備方式 

    螢光銅奈米團簇物質的合成方法有很多種，參考文獻
［4,5］

的合成方法，採用一鍋到底的方

式，即利用銅離子 Cu2+（硝酸銅在硝酸中）分別和巰基苯甲酸異構物（對巰基苯甲酸 4-MBA、

鄰巰基苯甲酸 TA）製備銅奈米團簇，而兩者的反應機構不相同，分別為： 

(1) 銅離子 Cu2+和對巰基苯甲酸 4-MBA 製備 MBA 銅奈米團簇 

    如圖三所示，對巰基苯甲酸4-MBA巰基上的硫與銅離子進行配位，先形成穩定的錯合物，

接著在 70℃下反應，溶液中過量的對巰基苯甲酸的巰基與巰基，形成 S-S 鍵，將電子釋出，
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銅離子還原成銅，即獲得銅(0)/銅(I)-MBA 的銅奈米團簇，為 MBA 銅奈米團簇。 

 

圖三 合成 MBA 銅奈米團簇的反應機構 

1. 取 5mL 規格的樣本瓶，反應需要避光，將樣本瓶身以鋁箔紙包起來，如圖四。 

2. 以鐵鍋盛 1000mL 的熱水，放在加熱板上，調整溫度，指針刻度落在 5.5 格處，放入溫度計，

20 分鐘後，鐵鍋內的水溫就維持在 70℃。 

3. 稱取對巰基苯甲酸（4-MBA）0.1547g，並以量筒量取 10mL 二甲基甲醯胺（DMF），將對巰

基苯甲酸（4-MBA）溶於二甲基甲醯胺 DMF 中，〔4-MBA〕=0.1M。 

4. 配置〔HNO3〕=0.1M，100mL，並同時稱取硝酸銅晶體 Cu(NO3)2∙3H2O 2.415 g，溶於前者的

硝酸中，〔Cu
2+
〕=0.1M，100mL。 

5. 以微量吸管先吸取 600μL 四氫呋喃（THF），更換吸頭，再以微量吸管吸取 300μL〔4-MBA〕

=0.1M，此時鎖緊樣本瓶蓋子，劇烈搖晃，使兩者混合均勻。 

6. 再次更換微量吸管吸頭，以微量吸管吸取 100μL〔Cu2+〕=0.1M，此時鎖緊樣本瓶蓋子，劇

烈搖晃 30 秒，溶液瞬間呈黃色混濁，以試管夾夾住樣本瓶，放入 2.中裝有 70℃的熱水內，反

應裝置如圖五並以大紙箱蓋住反應裝置，為使在整個反應過程中都是避光，隔水加熱 30 分

鐘。 

7. 加熱 30 分鐘後，樣本瓶分成兩層，上層為無色透明，下層為黃色沉澱，從熱水中移到暗處，

使之在室溫下回溫。 

8. 產物的量只有 1mL，故反覆 1.至 7.，共 5 次，才有足夠的量能探討銅奈米團簇物質的螢光

性質。 
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圖四 樣品以微量吸管吸取 圖五 以加熱攪拌器隔水加熱 

9. 因為在不同的反應瓶，所得的銅奈米團簇，結果會不同，為了能比較在不同的鹽類時的螢

光與有足夠的量，將反應物的量放大 5 倍。即 5.6.的步驟相同，但樣本瓶改以 10mL 的規格，

四氫呋喃（THF）3000μL、〔4-MBA〕=0.1M 1500μL、〔Cu2+〕=0.1M 500μL。 

10. 為了能比較在不同的鹽酸 HCl 濃度與氫氧化鈉 NaOH 時的螢光與有足夠的量，將反應物

的量放大 10 倍，即 5.6.的步驟相同，但樣本瓶改以 20mL 的規格，四氫呋喃（THF）6000μL、

〔4-MBA〕=0.1M 3000μL、〔Cu2+〕=0.1M 1000μL。 

(2) 銅離子 Cu2+和鄰巰基苯甲酸 TA 製備 TA 銅奈米團簇 

    如圖六所示，鄰巰基苯甲酸 TA 巰基上的硫及羧酸根上的氧與銅離子同時進行配位，先

形成穩定的錯合物，接著在 70℃下反應，溶液中過量的巰基苯甲酸的巰基與巰基，形成 S-S

鍵，將電子釋出，銅離子還原成銅，即獲得銅(0)/銅(I)-TA 的銅奈米團簇，為 TA 銅奈米團簇。 

 

圖六 合成 TA 銅奈米團簇的反應機構 

1. 取 5mL 規格的樣本瓶，反應需要避光，將樣本瓶身以鋁箔紙包起來，如圖四。 

2. 以鐵鍋盛 1000mL 的熱水，放在加熱板上，調整溫度，指針刻度落在 5.5 格處，放入溫度計，

https://zh.wikipedia.org/wiki/%E7%BE%A7%E5%9F%BA
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20 分鐘後，鐵鍋內的水溫就維持在 70℃。 

3. 稱取鄰巰基苯甲酸（TA）0.1547g，並以量筒量取 10mL 二甲基甲醯胺（DMF），將鄰巰基

苯甲酸（TA）溶於二甲基甲醯胺 DMF 中，〔TA〕=0.1M。 

4. 配置〔HNO3〕=0.1M，100mL，並同時稱取硝酸銅晶體 Cu(NO3)2∙3H2O 2.415 g，溶於前者的

硝酸中，〔Cu2+〕=0.1M，100mL。 

5. 以微量吸管先吸取 600μL 四氫呋喃（THF），更換吸頭，再以微量吸管吸取 300μL〔TA〕

=0.1M，此時鎖緊樣本瓶蓋子，劇烈搖晃，使兩者混合均勻。 

6. 再次更換微量吸管吸頭，以微量吸管吸取 100μL〔Cu2+〕=0.1M，此時鎖緊樣本瓶蓋子，劇

烈搖晃 30 秒，溶液瞬間呈黑色混濁，以試管夾夾住樣本瓶，放入 2.中裝有 70℃的熱水內，反

應裝置如圖五並以大紙箱蓋住反應裝置，為使在整個反應過程中都是避光，隔水加熱 30 分

鐘。 

7. 因為在不同的反應瓶，所得的銅奈米團簇，結果會不同，為了能比較在不同的鹽類時的螢

光與有足夠的量，將反應物的量放大 5 倍。即 5.6.的步驟相同，但樣本瓶改以 10mL 的規格，

四氫呋喃（THF）3000μL、〔TA〕=0.1M 1500μL、〔Cu2+〕=0.1M 500μL。 

二、螢光銅奈米團簇物質的螢光性質研究 

    對於螢光銅奈米團簇的研究，我們則以自製的螢光光譜儀［6,7］，以市售牙膏盒與空白 DVD

光碟片，製成分光器，接上數位相機，記錄色光分光影像，將分光後的影像，以影像分析軟

體 Image J及數據分析軟體Excel［8,9］，分析螢光的最大放射波長及螢光強度（裝置如圖七所示）。

由於在本次的研究裡，肉眼往分光器看，其實看不到螢光的分光，經過多次拍攝分光圖，調 

 

圖七 螢光偵測及螢光光譜轉換取得示意圖 

整數位相機的功能與參數，為將拍照功能轉到 M，ISO=1600，光圈=3.5，曝光時間=25 秒。而

標準光譜的校正，則以省電燈泡通電後會發射出多條特定波長的線光譜，以藍光波長 436.6nm，

綠光波長 546nm，紅光波長 611.6nm，將螢光分光圖與省電燈泡線光圖，疊圖比較，就可得知

螢光波長位置所在。 
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    以巰基苯甲酸異構物（4-MBA、TA）與銅離子合成銅奈米團簇，分別為 MBA 銅奈米團

簇、TA 銅奈米團簇，其在外觀與螢光放射波長、量子產率差異非常大，分別探討： 

（一）MBA 銅奈米團簇 

將樣本瓶從熱水中移到暗處，使之在室溫下回溫，產物分成上下兩層，上層為無色澄清

溶液，下層為黃色沉澱，搖盪樣本瓶，液體呈黃色懸浮液，將樣本瓶放在紫外燈上，以 365nm

照射，黃色懸浮液會有紅色的螢光，如圖八十七所示，但並不是每瓶都有紅色的螢光，當外

觀已有些微綠色出現時，就沒有紅色的螢光，以此方式，來判斷是否有螢光 MBA 銅奈米團簇

的生成。並與另一螢光 TA 銅奈米團簇比較在日光下外觀與在紫外燈下兩者的差異，如圖八

十六與八十七所示。合成螢光 MBA 銅奈米團簇，再現性不高，同時反應 5 瓶，會有 2 瓶無

法有紅色螢光。為研究其螢光性質，將有紅色螢光的產物倒在一起，其量才足夠放在方形試

管中。 

(1) 探討螢光 MBA 銅奈米團簇之螢光條件 

1. 紫外燈照射樣本瓶，有紅色螢光者，以滴管取出，置於方形試管中，方形試管含有 4mL 產

物，呈黃色懸浮物的液體，放在紫外燈上，波長 365nm 照射，以自製螢光儀，拍攝銅奈米團

簇的螢光分光照片（圖八）。 

2. 滴管取出 2mL 產物，加入 2mL 去離子水，即產物稀釋成 1/2，置於方形試管中，方形試管

含有 4mL 產物，呈黃色懸浮物的液體，放在紫外燈上，波長 365nm 照射，以自製螢光儀，拍

攝銅奈米團簇的螢光分光照片（圖九）。 

3. 將 2.中取出的產物，置於量筒內，加入丙酮，使整體體積為 4mL，置於方形試管中，呈淺

黃色懸浮物的液體，放在紫外燈上，波長 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢

光分光照片（圖十）。 

4. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖。（圖十一） 

5. 開啟影像分析軟體 Image J，在 File 處，選擇 Open，開啟 1.至 4.中的銅奈米團簇之螢光分光

照片（圖八至圖十）與省電燈泡之線光譜圖照片。 

    

圖八 銅奈米 圖九 稀釋 1/2 圖十 丙酮 圖十一 省電燈泡 

6. 在工具列 Image → Stacks → Images to Stack，將 5.中的照片疊在一起，得一 stack 的檔案。 

7. 使用矩形工具，選取一長方形範圍，工具列 Edit → Selection →Specify，設定矩形位置及

大小（表一）。再次選取工具列 Image → Duplicate → Duplicate Stack，就可以將特定的區域

疊圖比較。 

8 再次選取工具列 Analyze → Plot Profile，如此就可以得到橫軸為位置像素，縱軸為強度的
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省電燈泡光譜圖。 

9. 在省電燈泡光譜圖中，找到最左端的波峰座標數字（723），最右端的波峰座標數字（921）。 

10. Image J的工具列中，選Analyze → Tools → Curve Fitting，清除欄位的數字，再輸入723 546，

換行輸入 921 611，選 Fit，得線性函數 y= 0.33679x +360.43，因為省電燈泡中有汞，汞的激發

光中綠光波長 546nm，紅光波長 611nm，就可以將橫坐標的位置像素轉換成波長。 

表一 設定矩形位置及大小參數 

項目 數值 

Width 1312 

Height 180 

X Coordinate 1028 

Y Coordinate 2012 

11. 將省電燈泡光譜圖 x、y 數據全選，複製，並開啟另一軟體 Excel，將數據貼上，A 欄的數

據，以 y= 0.33679x +360.43 的比例，轉成在 C 欄，並將 B 欄的數據貼在 D 欄。 

13. 滑鼠點到 7.中 Duplicate 的第二張圖，為銅奈米團簇稀釋 1/2，鍵盤同時按 Ctrl+A，就可得

橫軸為像素，縱軸為螢光強度的銅奈米團簇稀釋 1/2 螢光光譜圖，由於像素的位置比例與省

電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 E、F 欄位，刪

除 E 欄位。 

14. 滑鼠點到 8.中 Duplicate 的第三張圖，為銅奈米團簇在丙酮中，鍵盤同時按 Ctrl+K，就可

得橫軸為位置像素，縱軸為螢光強度的銅奈米團簇在丙酮中螢光光譜圖，由於像素的位置比

例與省電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 F、G 欄

位，刪除 F 欄位。 

15. 選取 C 到 G 欄數據，刪除 E 欄數據（省電燈泡光譜），選取工作列的插入→散佈圖，即為

探討螢光銅奈米團簇條件之螢光光譜圖（圖七十五）。 

(2) 螢光 MBA 銅奈米團簇在不同鹽類溶液的螢光 

1. 滴管取出 2mL 螢光銅奈米團簇，加入 2mL 去離子水，即銅奈米團簇稀釋成 1/2，置於方形

試管中，方形試管含有 4mL 呈黃色懸浮物的液體，放在紫外燈上，波長 365nm 照射，以自製

螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十二）。 

2. 取 2mL 螢光銅奈米團簇，放入量筒中，放入方形試管中，再另取〔KNO3〕=0.2M，2mL 加

入，即銅奈米團簇濃度為稀釋成 1/2，玻棒沾取該溶液，以廣用試紙測其 pH 值=7，放在紫外

燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十三）。 

3 取 2mL 螢光銅奈米團簇，放入量筒中，放入方形試管中，再另取〔Pb(NO3)2〕=0.2M，2mL

加入，即銅奈米團簇濃度為稀釋成 1/2，玻棒沾取該溶液，以廣用試紙測其 pH 值=4，放在紫

外燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十四）。 
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圖十二 銅奈米 圖十三 KNO3 圖十四 Pb(NO3)2 

4. 取 2mL 螢光銅奈米團簇，放入量筒中，放入方形試管中，再另取〔Na2CO3〕=0.2M，2mL

加入，即銅奈米團簇濃度為稀釋成 1/2，玻棒沾取該溶液，以廣用試紙測其 pH 值=11，放在紫

外燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十五）。 

5. 取 2mL 螢光銅奈米團簇，放入量筒中，放入方形試管中，再另取〔(NH4)2SO4〕=0.2M，2mL

加入，即銅奈米團簇濃度為稀釋成 1/2，玻棒沾取該溶液，以廣用試紙測其 pH 值=5，放在紫

外燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十六）。 

6. 取 2mL 螢光銅奈米團簇，放入量筒中，放入方形試管中，再另取〔Cu2SO4〕=0.2M，2mL

加入，即銅奈米團簇濃度為稀釋成 1/2，玻棒沾取該溶液，以廣用試紙測其 pH 值=4，黃色沉

澱消失，表示已無螢光銅奈米團簇。 

7. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖十七）。 

   

圖十五 Na2CO3 圖十六 (NH4)2SO4 圖十七 省電燈泡 

8. 圖十二至圖十七的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 5.至 15.相同，則可

得銅奈米團簇在不同鹽類的螢光光譜圖（圖七十六）。 

(3) 稀釋成不同比例之螢光 MBA 銅奈米團簇的螢光 

1. 以滴管取出產物螢光銅奈米團簇，置於方形試管中 4mL，呈黃色懸浮物的液體，放在紫外

燈上，波長 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖十八）。 

2. 以量筒取產物 1mL 黃色懸浮液體，加水稀釋到體積為 5mL，即產物稀釋成 1/5，呈淺黃色

懸浮液，取 4mL 於放入方形試管中，放在紫外燈上，波長 365nm 照射，以自製螢光儀，拍攝

銅奈米團簇的螢光分光照片（圖十九）。 

3. 將 2.中 4mL 濃度是稀釋成 1/5 的產物，放入量筒中，加水稀釋到體積為 8mL，即產物稀釋

成 1/10，溶液呈淡黃色懸浮液，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，

以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十）。 

4. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖二十一）。 

5. 圖十八至圖二十一的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 5.至 15.相同，則
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可得銅奈米團簇稀釋成不同比例的螢光光譜圖（圖七十七）。 

    

圖十八 銅奈米 圖十九 稀釋 1/5 圖二十稀釋 1/10 圖二十一 省電燈泡 

 (4) 螢光 MBA 銅奈米團簇在加入不同濃度 HCl 的螢光 

    由(3)中稀釋的結果，我們發現，以稀釋 1/5 銅奈米團簇螢光強度最強，故以稀釋 1/5 作為

比較在加入不同濃度 HCl 的螢光： 

1. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=2M，2mL 加入，即溶液中〔HCl〕=1M，玻棒沾取該溶液，

以廣用試紙測其 pH 值=1，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以 365nm 照射，

以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十二）。 

2. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.2M，2mL 加入，即溶液中〔HCl〕=0.1M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=2，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以 365nm 照

射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十三）。 

3. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.02M，2mL 加入，即溶液中〔HCl〕=10-2M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=4，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十四）。 

4. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.002M，2mL 加入，即溶液中〔HCl〕=10-3M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=4，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十五）。 

    

圖二十二 

〔HCl〕=1M 

圖二十三 

〔HCl〕=10-1M 

圖二十四 

〔HCl〕=10-2M 

圖二十五 

〔HCl〕=10-3M 

5. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.0002M，2mL 加入，即溶液中〔HCl〕=10-4M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十六）。 
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6. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.00002M，2mL 加入，即溶液中〔HCl〕=10
-5
M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十七）。 

7. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔HCl〕=0.000002M，2mL 加入，即溶液中〔HCl〕=10-6M，玻棒沾

取該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖二十八）。 

8. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光圖（圖二十九）。 

    

圖二十六 

〔HCl〕=10-4M 

圖二十七 

〔HCl〕=10-5M 

圖二十八 

〔HCl〕=10-6M 

圖二十九 

省電燈泡 

9. 圖二十二至圖二十九的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 5.至 15.相同，

則可得銅奈米團簇在不同濃度 HCl 的螢光光譜圖（圖七十八）。 

(5) 螢光 MBA 銅奈米團簇在加入不同濃度 NaOH 的螢光 

    我們發現，當銅奈米團簇在加入 2mL〔NaOH〕=1M〜10-3M 時，黃色沉澱消失，並且也

無紅色的螢光，故： 

1. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.0002M，2mL 加入，即溶液中〔NaOH〕=10-4M，玻棒沾

取該溶液，以廣用試紙測其 pH 值=8，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十）。 

2. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淺黃色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.00002M，2mL 加入，即溶液中〔NaOH〕=10-5M，玻棒

沾取該溶液，以廣用試紙測其 pH 值=7，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十一）。 

3. 取 2mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.000002M，2mL 加入，即溶液中〔NaOH〕=10-6M，玻棒

沾取該溶液，以廣用試紙測其 pH 值=7，且銅奈米團簇濃度為稀釋成 1/5，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十二）。 

4. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖三十三）。 
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圖三十 

〔NaOH〕=10-4M 

圖三十一 

〔NaOH〕=10-5M 

圖三十二 

〔NaOH〕=10-6M 

圖三十三 

省電燈泡 

5. 圖三十至圖三十三的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 5.至 15.相同，則

可得銅奈米團簇在不同濃度 NaOH 的螢光光譜圖（圖七十九）。 

（二）合成螢光 TA 銅奈米團簇 

    將樣本瓶從熱水中移到暗處，使之在室溫下回溫，放置 48 小時，液體會從有黑色沉澱，

逐漸轉變呈黑褐色澄清溶液，而其螢光性質研究分別為： 

(1) 稀釋成不同比例之螢光 TA 銅奈米團簇 

1. 以量筒取產物 2mL 黑褐色溶液，加水稀釋到體積為 4mL，即產物稀釋成 1/2，溶液呈黑褐

色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米

團簇的螢光分光照片（圖三十四）。 

2. 將 1.中 4mL 濃度是 1/2 的銅奈米團簇液體，放入量筒中，加水稀釋到體積為 10mL，即產物

稀釋成 1/5，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以

自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十五）。 

3. 取 2.中 4mL 濃度是 1/5 的銅奈米團簇液體，放入量筒中，加水稀釋到體積為 8mL，即產物

稀釋成 1/10，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以

自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十六）。 

4. 取 3.中 4mL 濃度是 1/10 的銅奈米團簇液體，放入量筒中，加水稀釋到體積為 8mL，即產物

稀釋成 1/20，溶液呈無色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自

製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十七）。 

     

圖三十四 

釋 1/2 

圖三十五 

稀釋 1/5 

圖三十六 

稀釋 1/10 

圖三十七 

稀釋 1/20 

圖三十八 

省電燈泡 

5. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖三十八）。 

6. 開啟影像分析軟體 Image J，在 File 處，選擇 Open，開啟 1.至 5.中的銅奈米團簇之螢光分光

照片（圖三十四至圖三十七）與省電燈泡之線光譜圖（圖三十八）照片。 

7. 在工具列 Image → Stacks → Images to Stack，將 6.中的照片疊在一起，得一 stack 的檔案。 

8. 使用矩形工具，選取一長方形範圍，工具列 Edit → Selection →Specify，設定矩形位置及
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大小（表二）。再次選取工具列 Image → Duplicate → Duplicate Stack，就可以將特定的區域

疊圖比較。 

9. 再次選取工具列 Analyze → Plot Profile，如此就可以得到橫軸為位置像素，縱軸為強度的

省電燈泡光譜圖。 

10. 在省電燈泡光譜圖中，找到最左端的波峰座標數字（181），最右端的波峰座標數字（497）。 

表二 設定矩形位置及大小參數 

項目 數值 

Width 702 

Height 126 

X Coordinate 759 

Y Coordinate 1005 

11. Image J 的工具列中，選 Analyze → Tools → Curve Fitting，清除欄位的數字，再輸入 181 

436.6，換行輸入 497 611.6，選 Fit，得線性函數 y= 0.5538x +336.36，因為省電燈泡中有汞，汞

的激發光中藍光波長 436.6nm，紅光波長 611.6nm，就可以將橫坐標的位置像素轉換成波長。 

12. 將省電燈泡光譜圖 x、y 數據全選，複製，並開啟另一軟體 Excel，將數據貼上，A 欄的數

據，以 y= 0.5538x +336.36 的比例，轉成在 C 欄，並將 B 欄的數據貼在 D 欄。 

13. 滑鼠點到 8.中 Duplicate 的第二張圖，為銅奈米團簇稀釋 1/2，鍵盤同時按 Ctrl+A，就可得

橫軸為像素，縱軸為螢光強度的銅奈米團簇稀釋 1/2 螢光光譜圖，由於像素的位置比例與省

電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 E、F 欄位，刪

除 E 欄位。 

14. 滑鼠點到 8.中 Duplicate 的第三張圖，為銅奈米團簇稀釋 1/5，鍵盤同時按 Ctrl+K，就可得

橫軸為位置像素，縱軸為螢光強度的銅奈米團簇稀釋 1/5 螢光光譜圖，由於像素的位置比例

與省電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 F、G 欄位，

刪除 F 欄位。 

15. 滑鼠點到 8.中 Duplicate 的第四張圖，為銅奈米團簇稀釋 1/10，鍵盤同時按 Ctrl+K，就可得

橫軸為位置像素，縱軸為螢光強度的銅奈米團簇稀釋 1/10 螢光光譜圖，由於像素的位置比例

與省電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 G、H 欄

位，刪除 G 欄位。 

16. 滑鼠點到 8.中 Duplicate 的第五張圖，為銅奈米團簇稀釋 1/20，鍵盤同時按 Ctrl+K，就可得

橫軸為位置像素，縱軸為螢光強度的銅奈米團簇稀釋 1/20 螢光光譜圖，由於像素的位置比例

與省電燈泡是一致的，將此圖的 x、y 數據全選，複製，在軟體 Excel，將數據貼在 H、I 欄位，

刪除 H 欄位。 

17. 選取 C 到 H 欄數據，刪除 D 欄數據（省電燈泡光譜），選取工作列的插入→散佈圖，即為

稀釋成不同比例之螢光銅奈米團簇之螢光光譜圖（圖八十）。 
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(2) 螢光 TA 銅奈米團簇之廷得耳效應 

    由不同的稀釋比例中可知，以稀釋成 1/10 比例的螢光強度最強，以該比例進行廷得耳效

應，溶液呈無色，與純水一起照射雷射光（圖九十四）。 

(3) 螢光 TA 銅奈米團簇在不同溶劑的螢光 

1. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 10mL，即銅奈米團簇稀釋成

1/10，溶液呈淡褐色，玻棒沾取該溶液，以廣用試紙測其 pH 值=4，取 4mL 於放入方形試管中，

放在紫外燈上，以 365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖三十九）。 

2. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取 2mL 酒精加入，即銅奈米團簇稀釋成 1/10 是一樣的，並且溶液中有

一半是酒精，玻棒沾取該溶液，以廣用試紙測其 pH 值=4，放在紫外燈上，以 365nm 照射，

以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖四十）。 

3. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取 2mL 丙酮加入，即銅奈米團簇稀釋成 1/10 是一樣的，並且溶劑中有

一半是丙酮，玻棒沾取該溶液，以廣用試紙測其 pH 值=4，放在紫外燈上，以 365nm 照射，

以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖四十一）。 

    

圖三十九 銅奈米 圖四十 酒精 圖四十一 丙酮 圖四十二 省電燈泡 

4. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖四十二）。 

5. 圖三十九至圖四十二的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 6.至 17.相同，

則可得銅奈米團簇在不同溶劑的螢光光譜圖（圖八十一）。 

(4) 螢光 TA 銅奈米團簇在不同鹽類的螢光 

1. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 10mL，即銅奈米團簇稀釋成

1/10，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自製螢

光儀，拍攝銅奈米團簇的螢光分光照片（圖四十三）。 

2. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔KNO3〕=0.2M，2mL 加入，即銅奈米團簇濃度為稀釋成 1/10，玻

棒沾取該溶液，以廣用試紙測其 pH 值=6，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖四十四）。 

3. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔Na2CO3〕=0.2M，2mL 加入，即銅奈米團簇濃度為稀釋成 1/10，玻
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棒沾取該溶液，以廣用試紙測其 pH 值=10，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖四十五）。 

    

圖四十三 銅奈米 圖四十四 KNO3 圖四十五 Na2CO3 圖四十六 (NH4)2SO4 

4. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL 

放入方形試管中，再另取〔(NH4)2SO4〕=0.2M，2mL 加入，即銅奈米團簇濃度為稀釋成 1/10，

玻棒沾取該溶液，以廣用試紙測其 pH 值=4，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖四十六）。 

5. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔Na2HPO4〕=0.2M，2mL 加入，即銅奈米團簇濃度為稀釋成 1/10，

玻棒沾取該溶液，以廣用試紙測其 pH 值=8，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖四十七）。 

6. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔CaCl2〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=6，即銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm 照射，以自製螢光儀，拍

攝銅奈米團簇的螢光分光照片（圖四十八）。 

   

圖四十七 Na2HPO4 圖四十八 CaCl2 圖四十九 省電燈泡 

7. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖四十九）。 

8. 圖四十三至圖四十九的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 6.至 17.相同，

則可得銅奈米團簇在不同溶劑的螢光光譜圖（圖八十二）。 

(5) 螢光 TA 銅奈米團簇在不同重金屬的螢光 

1. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 10mL，即銅奈米團簇稀釋成

1/10，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自製螢

光儀，拍攝銅奈米團簇的螢光分光照片（圖五十）。 

2. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔PbNO3〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=3，即銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm 照射，以自製螢光儀，拍
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攝銅奈米團簇的螢光分光照片（圖五十一）。 

3. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔CuSO4〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=3，即銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm 照射，以自製螢光儀，拍

攝銅奈米團簇的螢光分光照片（圖五十二）。 

    

圖五十 銅奈米 圖五十一 Pb(NO3)2 圖五十二 CuSO4 圖五十三 ZnSO4 

4. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔ZnSO4〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=6，即銅奈米團簇濃度為稀釋成 1/10，，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖五十三）。 

5. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔FeSO4〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=4，即銅奈米團簇濃度為稀釋成 1/10，，放在紫外燈上，以 365nm 照射，以自製螢光儀，

拍攝銅奈米團簇的螢光分光照片（圖五十四）。 

6. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔CoCl2〕=0.2M，2mL 加入，玻棒沾取該溶液，以廣用試紙測其 pH

值=1，即銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm 照射，以自製螢光儀，拍

攝銅奈米團簇的螢光分光照片（圖五十五）。 

   

圖五十四 FeSO4 圖五十五 CoCl2 圖五十六 省電燈泡 

7. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖五十六）。 

8. 圖五十至圖五十六的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 6.至 17.相同，則

可得銅奈米團簇在不同重金屬的螢光光譜圖（圖八十三）。 

(6) 螢光 TA 銅奈米團簇在加入不同濃度 HCl 的螢光 

1. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 10mL，即銅奈米團簇稀釋成

1/10，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自製螢

光儀，拍攝銅奈米團簇的螢光分光照片（圖五十七）。 
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2. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=2M，2mL 加入，即溶液中〔HCl〕=1M，玻棒沾取該溶液，

以廣用試紙測其 pH 值=1，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm 照射，

以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖五十八）。 

3. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.2M，2mL 加入，即溶液中〔HCl〕=0.1M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=2，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖五十九）。 

4. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.02M，2mL 加入，即溶液中〔HCl〕=10-2M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=4，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十）。 

    

圖五十七  

銅奈米 

圖五十八 

〔HCl〕=1M 

圖五十九 

〔HCl〕=0.1M 

圖六十 

〔HCl〕=10-2M 

5. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.002M，2mL 加入，即溶液中〔HCl〕=10-3M，玻棒沾取該

溶液，以廣用試紙測其 pH 值=5，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十一）。 

6. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.0002M，2mL 加入，即溶液中〔HCl〕=10-4M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十二）。 

7. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.00002M，2mL 加入，即溶液中〔HCl〕=10-5M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十三）。 

8. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔HCl〕=0.000002M，2mL 加入，即溶液中〔HCl〕=10-6M，玻棒沾

取該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十四）。 

9. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能
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轉回 ISO，拍攝省電燈泡分光光譜圖（圖六十五）。 

     

圖六十一 

〔HCl〕=10-3M 

圖六十二 

〔HCl〕=10-4M 

圖六十三 

〔HCl〕=10-5M 

圖六十四 

〔HCl〕=10-6M 

圖六十五 

省電燈泡 

10. 圖五十七至圖六十五的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 6.至 17.相同，

則可得銅奈米團簇在不同濃度 HCl 的螢光光譜圖（圖八十四）。 

(7) 螢光 TA 銅奈米團簇在加入不同濃度 NaOH 的螢光 

1. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 10mL，即銅奈米團簇稀釋成

1/10，溶液呈淡褐色，取 4mL 於放入方形試管中，放在紫外燈上，以 365nm 照射，以自製螢

光儀，拍攝銅奈米團簇的螢光分光照片（圖六十六）。 

2. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=2M，2mL 加入，即溶液中〔NaOH〕=1M，玻棒沾取該溶

液，以廣用試紙測其 pH 值=11，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十七）。 

3. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.2M，2mL 加入，即溶液中〔NaOH〕=0.1M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=10，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十八）。 

4. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.02M，2mL 加入，即溶液中〔NaOH〕=10-2M，玻棒沾取

該溶液，以廣用試紙測其 pH 值=9，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以 365nm

照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖六十九）。 

    

圖六十六 

銅奈米 

圖 六十七 

〔NaOH〕=1M 

圖六十八 

〔NaOH〕=0.1M 

圖六十九 

〔NaOH〕=10-2M 

5. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.002M，2mL 加入，即溶液中〔NaOH〕=10-3M，玻棒沾

取該溶液，以廣用試紙測其 pH 值=8，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖七十）。 

6. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL
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放入方形試管中，再另取〔NaOH〕=0.0002M，2mL 加入，即溶液中〔NaOH〕=10-4M，玻棒沾

取該溶液，以廣用試紙測其 pH 值=8，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖七十一）。 

7. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.00002M，2mL 加入，即溶液中〔NaOH〕=10-5M，玻棒

沾取該溶液，以廣用試紙測其 pH 值=6，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖七十二）。 

8. 取 1mL 的螢光銅奈米團簇，放入量筒中，加水稀釋到體積為 5mL，溶液呈淡褐色，取 2mL

放入方形試管中，再另取〔NaOH〕=0.000002M，2mL 加入，即溶液中〔NaOH〕=10-6M，玻棒

沾取該溶液，以廣用試紙測其 pH 值=7，且銅奈米團簇濃度為稀釋成 1/10，放在紫外燈上，以

365nm 照射，以自製螢光儀，拍攝銅奈米團簇的螢光分光照片（圖七十三）。 

     

圖七十 

〔NaOH〕=10-3M 

圖七十一

〔NaOH〕=10-4M 

圖七十二 

〔NaOH〕=10-5M 

圖七十三 

〔NaOH〕=10-6M 

圖七十四 

省電燈泡 

9. 打開省電燈泡，接有數位相機的分光器，其狹縫處對準省電燈泡光源，數位相機拍照功能

轉回 ISO，拍攝省電燈泡分光光譜圖（圖七十四）。 

10. 圖六十六至圖七十四的分光圖則以 Image J 與 Excel 處理，其步驟與(1)中的 6.至 17.相同，

則可得銅奈米團簇在不同濃度 NaOH 的螢光光譜圖（圖八十五）。 

伍、研究結果 

一、螢光 MBA 銅奈米團簇螢光光譜圖 

1. 探討螢光 MBA 銅奈米團簇之螢光條件 

 

圖七十五 螢光 MBA 銅奈米團簇之螢光條件光譜圖 

2. 螢光 MBA 銅奈米團簇在不同鹽類溶劑環境 
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圖七十六 螢光 MBA 銅奈米團簇在不同鹽類溶劑環境之螢光光譜圖 

3. 螢光 MBA 銅奈米團簇在不同稀釋比例 

 

圖七十七 螢光 MBA 銅奈米團簇在不同稀釋比例之螢光光譜圖 

4. 螢光 MBA 銅奈米團簇在加入不同濃度 HCl  

 

圖七十八 螢光 MBA 銅奈米團簇在加入不同濃度 HCl 之螢光光譜圖 
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5. 螢光 MBA 銅奈米團簇在加入不同濃度 NaOH  

 

圖七十九 螢光 MBA 銅奈米團簇在加入不同濃度 NaOH 之螢光光譜圖 

二、螢光 TA 銅奈米團簇螢光光譜圖 

1. 不同稀釋比例的螢光 TA 銅奈米團簇 

 
圖八十 螢光 TA 銅奈米團簇在不同稀釋比例之螢光光譜圖 

2. 在不同溶劑的螢光 TA 銅奈米團簇 

 

圖八十一 螢光 TA 銅奈米團簇在不同溶劑的螢光光譜圖 

3. 在不同鹽類的螢光 TA 銅奈米團簇 
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圖八十二 螢光 TA 銅奈米團簇在不同鹽類的螢光光譜圖 

4. 在不同重金屬離子的螢光 TA 銅奈米團簇 

 

圖八十三 螢光 TA 銅奈米團簇在不同重金屬離子的螢光光譜圖 

5. 在不同鹽酸 HCl 濃度的螢光 TA 銅奈米團簇 

 

圖八十四  螢光 TA 銅奈米團簇在不同鹽酸 HCl 濃度的螢光光譜圖 
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6. 在不同氫氧化鈉 NaOH 濃度的螢光 TA 銅奈米團簇 

 

圖八十五 螢光 TA 銅奈米團簇在不同氫氧化鈉 NaOH 濃度的螢光光譜圖 

陸、討論 

    對於螢光銅奈米團簇物質的討論分成兩部分，一是合成螢光銅奈米團簇物質，二是螢光

銅奈米團簇物質螢光的性質： 

一、合成螢光銅奈米團簇物質 

    螢光銅奈米團簇的合成方式有多種方法，但是皆價格過高或超出能力範圍。參考文獻［4,5］

後，我們發現只要以一鍋到底的方式，就可以合成出螢光銅奈米團簇物質。 

1. 採用 Chang［4,5］的方法，利用銅離子 Cu2+作為團簇銅的來源。本次就是利用巰苯甲酸異構物

（對巰基苯甲酸 4-MBA、鄰巰基苯甲酸 TA），由於巰基苯甲酸上的巰基 SH 與羧酸根 COOH

的位置不同，得以控制銅奈米團簇大小實驗的過程方法皆相同，溶液瞬間呈黃色或黑色混濁，

再以鋁箔紙包裹樣本瓶避光，於 70℃的熱水中，隔水加熱反應 30 分鐘後，回到室溫，即為產

物。 

  

圖八十六（4-MBA，TA） 圖八十七（4-MBA，TA） 
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2. (1)螢光 MBA 銅奈米團簇回到室溫後，液體分成上下兩層，上層為無色液體，下層為黃色 

沉澱物。搖盪樣本瓶，液體呈黃色混濁（如圖八十六左瓶）。在紫外燈下有橘紅色螢光（如圖

八十六左瓶），說明已合成出螢光銅奈米團簇物質。 

(2) 螢光 TA 銅奈米團簇回到室溫後，液體分成上下兩層，上層為無色液體，下層為黑色沉澱

物。放置 48 小時後，液體變成黑色澄清。（如圖八十七右瓶）。在紫外燈下有藍色螢光（如圖

八十七右瓶），說明已合成出螢光銅奈米團簇物質。 

3.(1) 以自製螢光儀，拍攝螢光 MBA 銅奈米團簇物質之螢光分光圖（圖八十八），分光圖中有

紅光、黃光與綠光三種色光色帶，不同的色光代表銅奈米團簇粒徑大小不同。在分光圖的色

帶中，紅色色帶是主要組成的粒子（占約 85%），為粒徑較大的螢光銅奈米團簇物質，因此在

液體中，外觀是黃色沉澱，在拍攝螢光時，要先搖盪方形試管，使液體呈黃色混濁。分光圖

中還有較窄的黃色（占約 7%）與綠色（占約 8%）色帶，說明產物中也有粒徑比較小的粒子，

因此發出螢光放射波長較短的黃光與綠光，證明螢光 MBA 銅奈米團簇物質不是單一種粒徑的

粒子組成。螢光 MBA 銅奈米團簇物質，組成的粒子的粒徑皆較大，穩定性低，活性大，產物

放置 48 小時後，黃色沉澱變成綠色，表示銅原子氧化成銅離子，紅色螢光消失。 

(2) 螢光 MBA 銅奈米團簇物質之螢光分光圖以 Image J 與 Excel，轉換成縱座標為螢光強度，

橫坐標為波長的螢光光譜圖，圖八十九中的最大放射波長為 620nm（激發波長 365nm），與文

獻的報導（最大放射波長=646nm，激發波長 324nm）相差約 30nm。 

 

圖八十八 螢光分光圖 
 

 圖八十九 螢光光譜圖 

(3) 並非自製螢光光譜儀校正有問題，而是因螢光 MBA 銅奈米團簇物質粒子大，形成的過程

中，粒子大小控制的再現性不佳，粒子大小的分布隨實驗的狀態改變。放大合成的比例，為

1 倍（1mL）、5 倍（5mL）、10 倍（10mL），其螢光的顏色與螢光的強度不同（如圖九十），依

然以總體積 1mL 的比例螢光強度最強，同時發現，螢光光譜中（如圖九十一所示），在波長

440nm（藍光）、620nm（紅光）及 640nm（紅光）處（文獻中的螢光最大波長處）皆有放射波

長的波峰，為不同粒徑的螢光，表示粒徑大小分布範圍大，使得螢光顏色明顯不同。這也說
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明，不可隨意放大每次實驗的比例，倘若實驗的合成能在無氧狀態下（產物活性大，易氧化

成銅離子），並且也需以特殊裝置與方法純化產物，才有可能控制螢光 MBA 銅奈米團簇物質

粒子的粒徑。 

(4) 將產物放入離心管中，將離心機的轉速設定為 8000 轉/分離心後，將上層液移走，留下黃

色沉澱物，再加入等量的去離子水，如此反覆 3 次，再次放在紫外燈上，照射黃色物質，橘

紅色螢光消失，已無螢光銅奈米團簇物質，說明此產物活性相當高，結構易崩解。  

(  

圖九十  1 倍（1mL）、5 倍（5mL）、10

倍（10mL）  

 圖九十一 1 倍、5 倍、10 倍螢光光譜 

4. (1) 以自製螢光儀，拍攝螢光 TA 銅奈米團簇物質之螢光分光圖（圖九十二），分光圖中有

藍光、淺藍光兩種色光色帶，不同的色光則代表銅奈米團簇粒徑大小不同。在分光圖的色帶

中，藍色色帶是主要組成的粒子（占約 85%），為粒徑小的螢光銅奈米團簇物質，因此外觀為

黑褐色澄清液體，在拍攝螢光時，由於粒子濃度大，需稀釋液體。液體經稀釋後，以稀釋成

1/10 的螢光強度最強。分光圖中還有淺藍色（占約 7%）的色帶，說明也有粒徑比較大的粒子，

不是單一種粒徑的粒子組成。所以螢光 TA 銅奈米團簇物質的組成粒子的粒徑都比螢光 MBA 

銅奈米團簇小，在液體中為澄清溶液，穩定性也比較高，產物放置 4 星期，黑褐色澄清溶液 

 

圖九十二 螢光分光圖 

 

 圖九十三 螢光光譜圖 
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的外觀與螢光都不會改變。 

 (2) 螢光 TA 銅奈米團簇物質之螢光分光圖以 Image J 與 Excel，轉換成縱座標為螢光強度，

橫坐標為波長的螢光光譜圖，圖九十三中的最大放射波長為 420nm（激發波長 365nm），與文

獻的報導（最大放射波長 420nm，激發波長 338nm）相當一致。 

二、螢光 TA 銅奈米團簇之廷得耳效應 

    在本次的實驗，有兩種不同的螢光銅奈米團簇物質。由於螢光 MBA 銅奈米團簇的粒子粒

徑大，在各種溶液中分散效果差，都會沉澱，無法有廷得耳效應。而螢光 TA 銅奈米團簇原

本就是黑褐色澄清溶液，經由稀釋 1/10 後，放入方形試管，外觀已經是淺褐色澄清溶液，再

與純水比較，如圖九十四所示。綠色的雷射光束，通過此兩個方形試管時，只有螢光 TA 銅

奈米團簇此方形試管有綠色光徑。溶液中的溶質粒子粒徑在 1-100nm 才有此現象，稱為廷得

耳效應。證明螢光 TA 銅奈米團簇的粒徑在 1-100nm，是屬於奈米粒子。 

 

圖九十四 螢光 TA 銅奈米團簇之廷得耳效應 

三、螢光銅奈米團簇物質螢光性質的研究 

    本次的實驗裡有兩種不同螢光銅奈米團簇物質，為螢光 MBA 銅奈米團簇與螢光 TA 銅奈

米團簇，其外觀與螢光差異相當大，當改變螢光銅奈米團簇物質所在的環境：不同的鹽類環

境、不同濃度 HCl、不同濃度 NaOH 時，螢光強度是否有改變，以自製螢光光譜儀與 Image、

Excel 轉換的光譜圖來判斷。 

（一）螢光 MBA 銅奈米團簇 

(1) 最初螢光銅奈米團簇之螢光條件 

    文獻中［4］對螢光 MBA 銅奈米團簇的螢光探討條件並沒有詳細的說明。因此，在反應後

直接將產物從樣本瓶取出，在紫外燈照射下，螢光放射光譜圖（圖七十五）中的最大放射波

波長為 620nm，當加入一半體積的去離子水，螢光波長仍為 620nm，螢光強度減弱，推測可

能是發光粒子減少。而改成加入一半體積的丙酮時，螢光強度增強，可能因為丙酮是有機溶

劑，而螢光 MBA 銅奈米團簇的外圍是巰基苯甲酸，為有機分子（如圖九十五）。巰基苯甲酸

與丙酮之間作用，使發光的粒子更均勻分散於溶液中，以致螢光增強。 

(2) 螢光銅奈米團簇在不同鹽類環境的螢光：將多種實驗室中常用的鹽類，加入螢光銅奈米團
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簇液體中，反應後的結果外觀（如圖九十六）。加入硫酸銅溶液後，黃色沉澱消失，呈綠色混

濁，也無任何的螢光；而在鹼性的碳酸鈉溶液中，黃色沉澱消失，螢光相當弱；在弱酸性的

硫酸銨螢光也減弱；在中性鹽類硝酸鉀溶液、弱酸性硝酸鉛與，螢光也是減弱，說明在鹽類

的環境，螢光銅奈米團簇不穩定，螢光減弱，且在鹼性的環境易分解。推測銅奈米團簇外圍

苯甲酸上羧酸根與銅離子作用，而當在鹼性的環境，銅奈米團簇上的羧酸根彼此之間的排斥，

造成銅奈米團簇結構不穩定崩解。 

   

 

圖九十五 螢光MBA銅奈米團簇結構示意

圖 

圖九十六 螢光 MBA 銅奈米團簇在不同鹽類環

境的的外觀 

(3) 螢光銅奈米團簇的濃度效應：將螢光銅奈米團簇以不同體積的去離子水稀釋，我們發現稀

釋成原濃度的 1/5，其螢光的強度最強，如圖七十七。因此推測此種螢光銅奈米團簇粒徑大，

分散性差，發光粒子會沉澱，加水稀釋，雖然發光的粒子數減少，但當粒子稀釋成 1/5，發光

粒子反而較能均勻分散於溶液，才有較強的螢光。 

 (4) 螢光銅奈米團簇的酸鹼效應：將螢光銅奈米團簇放在不同濃度的鹽酸與氫氧化鈉中，在

鹽酸的環境中，圖七十八中，有 620nm 的放射波長外，在 440nm 也有，螢光的顏色呈現粉紅

色，可能螢光銅奈米團簇有些已瓦解成較小粒子，才會有藍色螢光在 440nm，故在酸中不穩

定；在較高濃度 0.1M〜10-3M 氫氧化鈉的溶液中，黃色沉澱消失，螢光銅奈米團簇全部分解

不見，呈現透明無色也無任何的螢光。而在更低濃度 10-4M〜10-6M 氫氧化鈉的溶液中，其螢

光光譜圖七十九，也是與在鹽酸的環境相同，皆有 620nm 與 440nm 的放射波長，也說明在 pH

值高的鹼性環境中，銅奈米團簇物質上的羧酸根彼此間靜電排斥力，使得粒子不穩定，表示

螢光銅奈米團簇也被瓦解成較小粒子，螢光的顏色也呈現粉紅色。 

（二）螢光 TA 銅奈米團簇物質 

(1) 螢光銅奈米團簇的濃度效應：當產物螢光 TA 銅奈米團簇物質從 70℃的熱水中回到室溫後，

為上下分層。上層為無色液體，下層則是黑色沉澱物，黑暗處放 48 小時後，液體轉變成黑褐

色澄清溶液。文獻報導，該螢光銅奈米團簇物質非常的安定，但並未詳細說明，當合成該產

物後，以何種濃度，分析其螢光。當在樣本瓶的產物以紫外燈照射時，只有較接近紫外燈附
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近的溶液，有非常強的藍色螢光，其他都是黑色。這是因為產物中會發光的粒子，濃度太高，

螢光會自吸收。因此，對產物先以去離子水稀釋，圖八十為在不同稀釋比例的螢光光譜圖，

以稀釋成 1/10 的螢光強度最強，而稀釋成 1/20，發光的粒子少，螢光強度下降。所以，有關

螢光 TA 銅奈米團簇物質螢光的研究，都是以稀釋成 1/10 的比例。 

 (2) 螢光銅奈米團簇的溶劑效應：從圖八十一的螢光光譜中我們可以發現，銅奈米團簇放射

波長為 431nm，螢光強度為 50；在酒精當中放射波長為 422nm，螢光強度為 76；在丙酮當中

放射波長為 424nm，螢光強度為 86。可從放射

波長得知，在有機溶劑中皆有藍位移現象及螢

光強度增強，故推測可能是酒精和丙酮會與螢

光 TA 銅奈米團簇外圍的苯環（如圖九十七）

作用，能階改變導致藍位移，也使發光的粒子

更均勻分散於溶液中，以致螢光增強。 

    探討螢光銅奈米團簇各種效應造成螢光增

強減弱，將螢光光譜圖八十二至八十三，轉成

螢光強度長條圖（如圖九十八），藉以比較： 

(3) 螢光銅奈米團簇的離子效應：原稀釋成 1/10

的螢光銅奈米團簇溶液 pH=6，在中性硝酸鉀 KNO3與氯化鈣 CaCl2中，溶液的 pH 值=6，呈現

微酸性；或在弱酸性硫酸銨(NH4)2SO4中，溶液的 pH 值=4，在酸性的環境中，這些溶液中，

又有 K+、NO3
-、Ca2+、Cl-、NH4

+及 SO4
2-離子，對螢光強度增加，而弱鹼性鹽類磷酸氫鈉 Na2HPO4

在溶液的 pH 值=8，鹼性鹽類碳酸鈉 Na2CO3溶液的 pH 值=10，螢光強度減弱非常多，以在碳

酸鈉中降低最多。說明鹽類離子的酸鹼環境，會影響螢光的強度。  

 

圖九十八 螢光強度長條圖 

(4) 螢光銅奈米團簇的重金屬效應：螢光銅奈米團簇在有 Zn2+、Pb2+、Co2+、Cu2+、Fe2+重金屬溶
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圖九十七 螢光 TA 銅奈米團簇結構示意圖 



 

28 

 

液中，呈現弱酸性（pH 值在 3〜4），且溶液中同時也有 NO3
-、Cl-、或 SO4

2-負離子，因為在(3)

中，這些效應，螢光並未增強。除了 Zn
2+
外，其他重金屬離子的螢光強度減弱，以 Cu

2+
、Fe

2+

降低最多，這表示確實是重金屬離子在影響螢光銅奈米團簇的螢光，比在酸鹼性或鹽類的影

響更大。未來可再對此兩種金屬多做深入探討，研究此種螢光銅奈米團簇是否可為重金屬 Cu2+、

Fe2+的檢測劑。 

(5) 螢光銅奈米團簇的酸鹼效應：將螢光銅奈米團簇放在不同濃度的鹽酸與氫氧化鈉中的螢光

光譜圖八十四至八十五，轉成螢光強度以長條圖（如圖九十九），藉以比較，可以發現，在溶

液中的 pH 值落在 4〜8，螢光強度會增強或不變，推測在銅奈米團簇上外圍的巰基與羧酸根

形成一穩定的分子內作用力，形成更密實的團簇結構（如圖九十七），能有穩定螢光的環境。 

 

圖九十九 螢光強度長條圖 

柒、結論 

1. 以銅離子分別與巰基苯甲酸異構物（對巰基苯甲酸 4-MBA、鄰巰基苯甲酸 TA），二甲基甲

醯胺（DMF）、四氫呋喃（THF）為溶劑，一鍋到底，反應在 70℃下 30 分鐘，即可合成粒徑

大小不同的螢光銅奈米團簇物質。 

2. 巰基苯甲酸在此反應中，是做為配位基與還原劑，當反應物為：(1)對巰基苯甲酸 4-MBA，

因為只有巰基上的硫與銅離子配位，所以會形成粒徑大的 MBA 銅奈米團簇。(2)鄰巰基苯甲

酸 TA 上的巰基的硫與酸根的氧與銅離子進行配位，所以會形成粒徑小的 TA 銅奈米團簇。因

此，藉由巰基苯甲酸上的巰基與酸根的位置，可控制銅奈米團簇粒徑大小。 

3. 自製的螢光光譜儀以市售牙膏盒與空白 DVD 光碟片，製成分光器，接上數位相機，記錄

色光分光影像，將分光後的影像，以影像分析軟體 Image J 及數據分析軟體 Excel 將螢光分光

圖與省電燈泡線光圖，疊圖比較，即得螢光的銅奈米團簇物質最大放射波長所在位置與螢光

強度。 

28
31.9

39.2
44.1 44.7

49.6 48.7

36.3
39.4

48.2
53.2

46.5

31 30.7 32

0

10

20

30

40

50

60

螢
光

強
度



 

29 

 

4. 粒徑大的螢光 MBA 銅奈米團簇，外觀是黃色沉澱，分散性差，不穩定，以紫外燈 365nm

照射下，會有紅色的螢光，以自製的螢光光譜儀分析後發現其最大放射波長為 620nm。由於

MBA 銅奈米團簇外圍苯甲酸上的羧酸根，其所在的環境，造成彼此間靜電排斥力，使得粒子

不穩定，影響螢光，故(1)溶劑效應裡：在丙酮有機溶劑中，紅色螢光增強。(2)濃度效應裡：

稀釋成原濃度的 1/5，螢光強度最強。(3)離子效應裡：在中性的硝酸鉀、弱酸性的硫酸銨、硝

酸鉛溶液中，螢光強度減弱。在鹼性的鹽類碳酸鈉、硫酸銅溶液中，銅奈米團簇會分解，螢

光消失。(4)酸鹼效應：在氫氧化鈉濃度大於 10-3M 的溶液中，螢光銅奈米團簇會分解；在低

濃度的氫氧化鈉溶液與鹽酸溶液中，螢光 MBA 銅奈米團簇不穩定，有些會分解成較小粒徑，

除了原有的紅色螢光，也會有藍色的螢光。 

5. 粒徑小的螢光 TA 銅奈米團簇，外觀是黑褐色澄清液體，非常穩定，有廷得耳效應，是粒

徑在 1-100 奈米的奈米粒子證據，以紫外燈 365nm 照射下，會有藍色的螢光，以自製的螢光

光譜儀分析後發現其最大放射波長為 420nm。當在(1)濃度效應裡：產物稀釋成原濃度的 1/10，

可達最大的螢光強度。(2)溶劑效應裡：在有機溶劑中，藍色螢光都會大幅增強，尤其是在丙

酮的溶劑中。(3)重金屬效應：在有 Cu2+、Fe2+的溶液中，螢光強度減弱一半，(4)酸鹼效應：在

pH 值 4〜8，藍色螢光強度會增強，這是銅奈米團簇上的巰基與羧酸根形成一穩定的分子內作

用力，形成更密實的結構，提供螢光 TA 銅奈米團簇適合有螢光的環境。 

6. 不同於在日光下有紅色金屬光澤、不具備螢光的銅塊材，當只有數十個銅原子聚集成銅奈

米團簇，粒徑大小為 1-100 奈米，在紫外燈下可有橘紅色與藍色的螢光，控制其溶劑、鹽類、

pH 值的環境，螢光可穩定發光，未來在檢測或金屬發光材料裡具有潛力。 
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作品海報 

【評語】030216  

此研究利用一鍋化合成螢光銅奈米簇，並使用自組裝之儀器分

析方法鑑定其螢光性質。整體架構完整且題材新穎。以下的建議供

參考： 

1. 如何證實銅奈米簇有生成，不同發光的銅奈米簇其發光的機

制為何？需加以說明。 

2. 如何將成果應用在日常生活，較無說明。  
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摘要 

    以巰基苯甲酸異構物（對巰基苯甲酸、鄰巰基苯甲酸）與硝

酸銅為反應物，巰基苯甲酸做為配位基與還原劑，採一鍋到底的

方式，反應在 70℃下 30 分鐘，可分別合成出粒徑大、分散性差黃

色沉澱並有橘紅色螢光的銅奈米團簇與粒徑小、黑褐色澄清液體

具有藍色螢光的銅奈米團簇。接著以自行設計的簡易螢光光譜儀

分析，橘紅色螢光的最大放射波長為 620 奈米，在丙酮溶劑中，

螢光增強，對 pH 值有依賴，並在鹽類、鹼性溶液中，非常不穩定，

銅奈米團簇會分解，黃色沉澱與螢光消失；藍色螢光的最大放射

波長為 420 奈米，在丙酮、酒精中，螢光增加，另外控制溶液的

pH 值 4〜8 與特定鹽類時，可使螢光強度增加，並且穩定性佳，未

來具有做為金屬奈米螢光材料的潛能。 

壹、研究動機 

    二年級自然與生活科技的單元「物質的基本結構」，介紹物

質是由原子所組成。當原子規則、緊密堆積成數千億兆個時成塊

材，是巨觀的視野，就如圖一中的銅片，具有紅色的金屬光澤。 

  
圖一  銅片與銅奈米團簇 

（在日光下） 

圖二  銅片與銅奈米團簇 

（在暗處） 

銅是自然界中，重要的金屬元素之一，因為其導電性佳，價格便

宜，多用於導線，也可與其他的金屬，製成青銅、黃銅等合金，

用途廣泛［1］。近年來，最為關注的議題，就是奈米科技，當物質

的粒子，所組成的原子數十個，其粒徑在 1-100 奈米時，表現在物

理與化學性質，是截然不同於巨觀的情形，如圖一中，是由數十

個銅原子聚集在一起，表層有巰基配位錯合物所組成的銅物質，

以膠體的方式懸浮於溶劑中，呈黑褐色，不再如銅片一樣，具有

金屬光澤。在暗處，照射紫外燈，可發出藍色的螢光，如圖二，

類似分子的特性，這樣銅的組成，稱為「螢光銅奈米團簇」［2,3］。文

獻報導指出，「螢光銅奈米團簇」是銜接單一銅原子與塊材（銅片）

間的性質，有良好的化學穩定性，毒性低，其表層亦含有官能基，

可增加奈米團簇對於分析物的選擇性或生物辨識性，於化學、生

物檢測、材料及催化方面具有潛力。因此，對於平日所見的銅，

尺寸落在奈米等級時，竟然可以有螢光，呼應老師在介紹奈米知

識時，物質在巨觀與微觀的視野，性質迥然不同，我們覺得十分

的有趣，想一探「螢光銅奈米團簇」其中的奧妙之處。 

貳、研究目的 

由於銅奈米團簇擁有極小且均一的尺寸，優異的光穩定性，故本

實驗的研究目的有： 

一、合成螢光銅奈米團簇物質 

二、以自製的螢光光譜儀分析研究螢光銅奈米團簇物質的螢光性

質 

參、研究設備及器材 

一、研究設備 

1. 電子天平；2. 水銀溫度計；3. 加熱攪拌器；4. 微量吸管；5. 自

製分光器 1 個；6. 數位照相機；7. 紫外燈；8. 影像分析軟體   

Image J；9. 數據分析軟體 Microsoft Office Excel 2007 

二、研究藥品 

1. 硝酸銅 Cu(NO3)2∙6H2O；2. 硝酸 HNO3；3. 

四氫呋喃 （THF）；4. 二甲基甲醯胺（DMF）：

5. 對巰基苯甲酸（4-MBA）5g；6. 鄰巰基

苯甲酸（TA）；7.酒精；8. 丙酮；9. 鹽酸

HCl；10. 硝酸鉀 KNO3；11. 氯化鈣

CaCl2∙2H2O；12. 六水合硫酸銨亞鐵

Fe(NH4)2(SO4)2∙6H2O；13. 硫酸 CuSO4∙5H2O；

14. 硫酸銨(NH4)2SO4；15. 氯化亞鈷

CoCl∙6H2O；16. 硝酸鉛 Pb(NO3)2；17. 硫酸

鋅 ZnSO4；18. 碳酸鈉 Na2CO3 500g；19. 磷酸

氫鈉 Na2HPO4 ∙12H2O；20. 氫氧化鈉 NaOH  

肆、研究過程或方法 

    研究過程分成兩部分，一是合成螢光銅奈米團簇物質，二是

探討螢光銅奈米團簇物質的螢光性質： 

一、合成螢光銅奈米團簇物質：螢光銅奈米團簇的製備方式 

    螢光銅奈米團簇物質的合成方法有多種方法，參考文獻［4,5］，

以一鍋到底的方式，利用銅離子 Cu
2+
（硝酸銅在硝酸中）分別和巰

基苯甲酸異構物（對巰基苯甲酸 4-MBA、鄰巰基苯甲酸 TA）製備

銅奈米團簇，兩者的反應機構不相同，分別為 

(1) 銅離子 Cu2+和對巰基苯甲酸 4-MBA 製備螢光銅奈米團簇 

 

圖三 合成 MBA 銅奈米團簇的反應機構 

    如圖三所示，對巰基苯甲酸 4-MBA 巰基上的硫與銅離子進行

配位，先形成穩定的錯合物，接著在 70℃下反應，溶液中過量的

對巰基苯甲酸的巰基與巰基，形成 S-S 鍵，將電子釋出，銅離子還

原成銅，即獲得銅(0)/銅(I)-MBA 的銅奈米團簇，為 MBA 銅奈米團

簇。 

(2) 銅離子 Cu2+和鄰巰基苯甲酸 TA 製備螢光銅奈米團簇 

 

圖四 合成 TA 銅奈米團簇的反應機構 

如圖四所示，鄰巰基苯甲酸 TA 巰基上的硫及羧酸根上的氧與銅離

子同時進行配位，先形成穩定的錯合物，接著在 70℃下反應，溶

液中過量的巰基苯甲酸的巰基與巰基，形成 S-S 鍵，將電子釋出，

銅離子還原成銅，即獲得銅(0)/銅(I)-TA 的銅奈米團簇，為 TA 銅奈

米團簇。 

  
圖五 樣品以微量吸管吸取 圖六 以加熱攪拌器隔水加熱 

    取 5mL 規格的樣本瓶，反應需要避光，將樣本瓶以鋁箔紙包

覆。準備一鍋 1000mL，水溫維持在 70℃的熱水。秤取 4-MBA 0.1547g，

並以量筒量取10mL DMF，將4-MBA溶於DMF中，〔4-MBA〕=0.1M。

配置〔HNO3〕=0.1M，100mL，並同時稱取 Cu(NO3)2∙3H2O 2.415 g，

溶於前者的硝酸中，〔Cu2+〕=0.1M，100mL。以微量吸管先吸取 600

μL THF，更換吸頭，再以微量吸管吸取 300μL〔4-MBA〕=0.1M，

此時鎖緊樣本瓶蓋子，劇烈搖晃，使兩者混合均勻。接著隔水加

熱 30 分鐘後，將樣本瓶放置到暗箱中冷卻，即可得到螢光銅奈米

團簇物質。 

圖七 螢光偵測及螢光光譜轉換取得示意圖 



二、螢光銅奈米團簇物質的螢光性質研究 

    自製的螢光光譜儀，是以市售牙膏盒與空白 DVD 光碟片，製成分光器，

接上數位相機，記錄色光分光影像，將分光後的影像，以影像分析軟體 Image 

J 及數據分析軟體 Excel，分析螢光的最大放射波長及螢光強度（裝置如圖七

所示）。拍照功能轉到 M，ISO=1600，光圈=3.5，曝光時間=25 秒。而標準光

譜的校正，則以省電燈泡通電後會發射出多條特定波長的線光譜，以藍光波

長 436.6nm，綠光波長 546nm，紅光波長 611.6nm，將螢光分光圖與省電燈泡

線光圖，疊圖比較，就可得知螢光強度最大放射波長位置所在。 

（一）MBA 銅奈米團簇之螢光分光圖 

       

○1省電燈泡          ○2銅奈米            ○3 稀釋 1/2          ○4丙酮 

        

○5 Na2CO3           ○6 (NH4)2SO4                       ○7稀釋 1/5          ○8 稀釋 1/10 

        

○9 〔HCl〕=1M     ○10〔HCl〕=10
-3
M     ○11〔NaOH〕=10

-4
M     ○12〔NaOH〕=10

-5
M  

（二）TA 銅奈米團簇之螢光分光圖 

        

○13稀釋 1/2           ○14稀釋 1/5           ○15稀釋 1/10          ○16稀釋 1/20 

        

○17酒精              ○18丙酮              ○19KNO3             ○20Na2CO3 

        

○21(NH4)2SO4            ○22CuSO4             ○23ZnSO4             ○24FeSO4 

        

○25〔HCl〕=1M       ○26〔HCl〕=10
-5
M      ○27〔NaOH〕=1M    ○28〔NaOH〕=10

-5
M 

伍、研究結果 

一、MBA 銅奈米團簇螢光光譜圖 

  
圖八 螢光銅奈米團簇之螢光條件光譜圖      圖九 在不同鹽類溶劑環境之螢光光譜圖 

 

 

    圖十  不同稀釋比例之螢光光譜圖         圖十一 不同濃度 HCl 之螢光光譜圖 

 

圖十二 不同濃度 NaOH 之螢光光譜圖          圖十三 不同合成體積之螢光光譜圖 

二、TA 銅奈米團簇螢光光譜圖 

 
圖十四 不同稀釋比例之螢光光譜圖          圖十五 不同溶劑中的螢光光譜圖 

 
  圖十六 在不同鹽類中的螢光光譜圖         圖十七 在不同重金屬離子中的螢光光譜圖 

 
   圖十八 不同 HCl 濃度的螢光光譜圖       圖十九 不同 NaOH 濃度的螢光光譜圖 

陸、討論 

    對於螢光銅奈米團簇物質的討論分成兩部分，一是合成螢光銅奈米團簇

物質，二是螢光銅奈米團簇物質螢光的性質： 

一、 合成螢光銅奈米團簇物質 

    螢光銅奈米團簇的合成方式，採用 Chang［34］的方法，利用銅離子 Cu2+作

為團簇銅的來源，巰基苯甲酸做為配位基與還原劑，巰基苯甲酸上的巰基 SH

配位 Cu2+，多餘的巰基苯甲酸再去還原銅離子 Cu2+成銅原子，就能合成出銅

奈米團簇，本次就是利用巰苯甲酸異構物（對巰基苯甲酸 4-MBA、鄰巰基苯

甲酸 TA），由於巰基苯甲酸上的巰基 SH 與羧酸根 COOH 的位置不同，得以

控制銅奈米團簇大小。 

1. MBA 銅奈米團簇，在日光下，液體呈黃色混濁；暗箱下，以紫外燈 365nm

照射，有橘紅色螢光，而為粒徑較大的螢光銅奈米團簇物質，穩定性低，活

性大，產物放置 48 小時後，黃色沉澱變成藍色，表示銅原子氧化成銅離子，

紅色螢光消失。 

2. TA 銅奈米團簇，在日光下，液體呈黑色澄清；暗箱下，以紫外燈 365nm 照

射，有藍色螢光，組成粒子的粒徑都比螢光 MBA 銅奈米團簇小，在液體中

為澄清溶液，穩定性也比較高。 

     
          圖二十 在日光下(MBA，TA)      圖二十一在紫外燈下(MBA，T A) 

      
           圖二十二 MBA 螢光分光圖           圖二十三 TA 螢光分光圖 



3. MBA 銅奈米團簇之螢光分光圖中有紅光、黃光與綠光三種色光

色帶，代表不是單一種粒徑的粒子組成。 

4. TA 銅奈米團簇之螢光分光圖中有藍光、淺藍光兩種色光色帶，

代表不是單一種粒徑的粒子組成。 

5. MBA 銅奈米團簇最大放射波長，為 620nm（激發波長 365nm），

與文獻的報導（最大放射波長=646nm，激發波長 324nm），相差約

30nm。 

6. TA 銅奈米團簇最大放射波長，為 420nm（激發波長 365nm），與

文獻的報導（最大放射波長=420nm，激發波長 338nm），相當一致。 

  

  圖二十四 4-MBA 螢光光譜圖         圖二十五 TA 螢光光譜圖 

7. MBA 螢光銅奈米團簇在不同鹽類環境的螢光，螢光銅奈米團

簇不穩定，螢光減弱，且在鹼性的環境易分解。 

8. TA 螢光銅奈米團簇之廷得耳效應：經由稀釋 1/10 後有綠色光

徑，在溶液中的溶質粒子，其粒徑在 1-100nm，才有此現象，稱

為廷得耳效應。 

    
    圖二十六 廷得耳效應           圖二十七 不同鹽類環境的的外觀 

9. MBA 螢光銅奈米團簇的最大放射波波長為 620nm，當加入一半

體積的去離子水後螢光波長仍為 620nm，螢光強度減弱，推測可能

是因為發光粒子減少。而改成加入一半體積的丙酮時，螢光強度

增強，可能因為丙酮是有機溶劑，而螢光 MBA 銅奈米團簇的外圍

是巰基苯甲酸，為有機分子。巰基苯甲酸與丙酮之間作用，使發

光的粒子更均勻分散於溶液中，以致螢光增強。 

10. TA 螢光銅奈米團簇放射波長為 431nm，螢光強度為 50；在酒

精當中放射波長為 422nm，螢光強度為 76；在丙酮當中放射波長

為 424nm，螢光強度為 86。可從放射波長得知，在有機溶劑中皆

有藍位移現象及螢光強度增強，故推測可能是酒精和丙酮會與螢

光 TA 銅奈米團簇外圍的苯環作用，能階改變導致藍位移，也使發

光的粒子更均勻分散於溶液中，以致螢光增強。 

 

 

 圖二十八 MBA 銅奈米團簇結構示意圖 圖二十九 TA 銅奈米團簇結構示意圖 

二、螢光銅奈米團簇物質螢光（TA）的研究 

1.濃度效應：以稀釋成 1/10 的螢光強度最強。2.溶劑效應：以丙酮

螢光強度最強。3.離子效應：在鹼性鹽類的環境中，螢光強度降低

最多。4.重金屬效應：以 Cu2+、Fe2+降低最多，可再對此兩種金屬

多做深入探討，對重金屬 Cu2+、Fe2+的檢測劑。 

 
圖三十 銅奈米團簇在不同鹽類與溶劑中的螢光強度長條圖 

5.酸鹼效應：在溶液中的 pH 值落在 4〜8，螢光強度會增強或不變，

這是因為此銅奈米團簇上的巰基與羧酸根形成一穩定的分子內作

用力，形成更密實的結構。 

 

圖三十一 銅奈米團簇在不同 pH 值中的螢光強度長條圖 

柒、結論 

1. 以銅離子分別與巰基苯甲酸異構物（對巰基苯甲酸 4-MBA、鄰

巰基苯甲酸 TA），二甲基甲醯胺（DMF）、四氫呋喃（THF）為溶

劑，一鍋到底，反應在 70℃下 30 分鐘，即可合成粒徑大小不同的

螢光銅奈米團簇物質。 

2. 巰基苯甲酸在此反應中，是做為配位基與還原劑，當反應物為：

(1)對巰基苯甲酸 4-MBA，因為只有巰基上的硫與銅離子配位，所

以會形成粒徑大的 MBA 銅奈米團簇。(2)鄰巰基苯甲酸 TA 上的巰

基的硫與酸根的氧與銅離子進行配位，所以會形成粒徑小的 TA 銅

奈米團簇。因此，藉由巰基苯甲酸上的巰基與酸根的位置，可控

制銅奈米團簇粒徑大小。 

3. 自製的螢光光譜儀以市售牙膏盒與空白 DVD 光碟片，製成分光

器，接上數位相機，記錄色光分光影像，將分光後的影像，以影

像分析軟體 Image J 及數據分析軟體 Excel 將螢光分光圖與省電燈

泡線光圖，疊圖比較，即得螢光的銅奈米團簇物質最大放射波長

所在位置與螢光強度。 

4. 粒徑大的螢光 MBA 銅奈米團簇，外觀是黃色沉澱、分散性差、

不穩定、有紅色的螢光，最大放射波長為 620nm。由於 MBA 銅奈

米團簇外圍苯甲酸上的羧酸根，其所在的環境，造成彼此間靜電

排斥力，使得粒子不穩定，影響螢光，故(1)溶劑效應裡：在丙酮

有機溶劑中，紅色螢光增強。(2)濃度效應裡：稀釋成原濃度的 1/5，

螢光強度最強。(3)離子效應裡：在鹼性鹽類碳酸鈉、硫酸銅溶液

中，銅奈米團簇會分解，螢光消失。(4)酸鹼效應：在氫氧化鈉濃

度大於 10-3M 的溶液中，螢光銅奈米團簇會分解，或不穩定時，分

解成較小粒徑，除了原有的紅色螢光，也會有藍色的螢光。 

5. 粒徑小的螢光 TA 銅奈米團簇，外觀是黑褐色澄清液體，非常

穩定，有廷得耳效應，是粒徑在 1-100 奈米的奈米粒子證據，有藍

色的螢光，最大放射波長為 420nm。當在(1)濃度效應裡：產物稀

釋成原濃度的 1/10，螢光強度為最強。(2)溶劑效應裡：在有機溶

劑中，藍色螢光都會大幅增強，尤其是在丙酮的溶劑中。(3)重金

屬效應：在有 Cu2+、Fe2+的溶液中，螢光強度減弱一半，(4)酸鹼效

應：在 pH 值 4〜8，藍色螢光強度會增強，這是銅奈米團簇上的巰

基與羧酸根形成一穩定的分子內作用力，形成更密實的結構，提

供螢光 TA 銅奈米團簇適合有螢光的環境。 

6.當只有數十個銅原子聚集成銅奈米團簇，粒徑大小為1-100奈米，

有橘紅色與藍色的螢光，控制其溶劑、鹽類、pH 值的環境，螢光

可穩定發光，未來在檢測或金屬發光材料裡具有潛力。 
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